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Revision History

Date Description
June 1, 2017 Updated Qualified Workstations and Laptops.
February 24, 2017 Added MCDEV-6862 and COGS-2560 to Limitations.

IMPORTANT: Avid periodically makes software updates available for download on
Avid.com at the following location:www.avid.com/us/support/downloads. Please
check the above site regularly for information on available downloads for your
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation was
published.

This document describes compatibility issues with previous releases, software installation
instructions, hardware and software requirements, and summary information on system and
memory requirements. This document also lists hardware and software limitations.


http://www.avid.com/support/downloads
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders,
recommendations, and strong suggestions.

& A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

@ A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.



If You Need Help

Symbol or Convention Meaning or Action

b This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

(Windows), (Windows This text indicates that the information applies only to the specified
only), (Macintosh), or operating system, either Windows or Macintosh OS X.

(Macintosh only)

Bold font Bold font is primarily used in task instructions to identify user interface

items and keyboard sequences.
Italic font Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action  Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the
documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends
that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport

New in Media Composer v8.8

New in Media Composer v8.8

New Features: For information on new features, see the What’s New v&8.8.

New Nvidia Driver: Nvidia Driver v375.86 is supported with this release.

Fixed in Media Composer v8.8

The following have been fixed:
»  Bug Number: MCCET-1541. You could not open a project if the project was named Clip.

»  Bug Number: MCCET-1602. In some instances you could not successfully drag and drop audio
clips above or below the TC track.

»  Bug Number: MCCET-1638. Custom Colors did not stay in the Color Palette when using Clip
Color.

»  Bug Number: MCCET-1388. Disabling the “Auto-create new tracks” setting was ignored when
using Edit While Capture clips.

»  Bug Number: MCCET-1572. (List Tool) The Cutlist EndHdl timecode was short one frame.
»  Bug Number: MCCET-1568. (List Tool) The marker values were empty in an Optical List.

»  Bug Number: MCCET-1567. (List Tool) Markers did not display on Opticals in an Assemble
List.

»  Bug Number: MCCET-1636. When performing an Export to Device with an XDCAM device
attached, you might have received a “Please connect XDCAM device or insert disk” message.

> Bug Number: MCCET-1627. In some instances, exporting a graphic from linked XAVC Long
GOP media failed with an assertion error.

»  Bug Number: MCCET-1671. In some instances, rendering a sequence with muted clips resulted
in clips being partially rendered.

»  Bug Number: MCCET-1679. The Project Window summary might have been empty on a Mac
system, or contained garbled text on a Windows system.


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation

Limitations

Bug Number: MCCET-495. When importing some .wav files, the name of the files include a “/”
which is an illegal character that is not supported in Interplay. This is because Media Composer
uses the values of “Scene/Take” for the file name when importing Broadcast Wave files. An
additional Import Setting has been added to the Import Settings dialog. The “Use Broadcast
Wave Scene and Take for Clip Names” is defaulted on. If you are importing Broadcast Wave files
and you do not want them named using Scene/Take, you must deselect this option in the Import
Settings: Audio dialog box.

Limitations

>

Bug Number: MCDEV-6862. Occasionally, when working with media with effects or media
where space, time or color adapters were rendered during transcode or video mixdown, you
might see artifacts during playback or export.

Workaround: Go to the Render Settings dialog and choose Disable GPU effects.

Bug Number: COGS-2560. While working in the Script Window, text operations
(cut/copy/paste/delete/editing) can only be done in edit mode. See What’s New v8.8 for
information on edit mode in the Script Window.


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation

Before Installing the Editing Application

Bug Number: MCDEV-5379. When in the Source Browser, linking to an XAVC Long GOP
volume does not work properly.

Workaround: You can link to individual XAVC Long GOP files at the following location:
Volume Name\PRIVATE\XDROOT\Clip

Bug Number: MCDEV-5650. When working with Panasonic LongG media, you might receive
an “SFPlayConsumer Timeout” error if audio waveforms are enabled.

Workaround: Turn off audio waveforms.

Bug Number: MCDEV-5891. Media Composer v8.6 on Mac OS does not support send to
playback (STP) of AVC-LongG media.

Workaround: Scrub back to the available media.

Bug Number: MCDEV-5385. Multicam editing with Panasonic LongG media is not supported
with this release.

Bug Number: MCDEV-5384. Currently, when working with LongG media, you might see
dropped frames when editing 4 streams. This might occur when playing from a single stream to
multiple streams (and from multiple streams back to a single stream). The dropped frames
usually display around the edit point (transition to a different stream).

Before Installing the Editing Application

A

Before Installing the Editing Application in an Avid Interplay Environment

Please note the following before you install the editing application in an Avid Interplay
environment.

Media Composer v8.7 and higher requires Avid Interplay client v3.7 and higher.
Upgrading to Mac OS v10.11.x

(Mac) If you upgrade to Mac OS 10.11.x, you must uninstall Media Composer. Reinstall Media
Composer after you perform the OS upgrade. If you use Avid Artist DNxIO, you must also
uninstall the Desktop Video software and reinstall it after the OS upgrade.

Installation Information

Read through the Installation Guide for Avid Editing Applications. This document is available on
the Knowledge Base.



Before Installing the Editing Application

If you are upgrading from v7.x to v8.x, you must uninstall the Avid Transcode Service and the
Avid Editing application. Beginning with version 8.0 of the editing application, the Transcode
Service is included as part of the editing application and is no longer a separate program. When
you uninstall Media Composer v8.0, a separate uninstall of Transcode service is no longer
necessary.

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing
application on a system with less than 8GB RAM, you will receive a buffer error and installation
will not proceed.

Supported Systems Message

A new message has been added to this release that detects if you are installing on an unsupported
system: “Your system does not support this version of Media Composer | Software. Please
consult the Specifications information on Avid.com for supported configurations. Media
Composer | Software installation will be aborted.”

Media Composer 8.3 and newer systems require a micro architecture that supports the SSE 4.1
CPU Instruction set. Most systems shipped since 2008 with four or more processor cores, i.e.
Quad core, will include this functionality. Systems shipped before 2008 are not likely to support
this functionality and Media Composer will fail to install.

If you receive the message, go here to review system requirements.
Sentinel Error Message

(MCDEV-2394) On a Windows 7 system, if a “Failed to add Sentinel64.cat file.” error appears
during the installation, you can safely click OK to continue with the installation. Dongle
activation will work properly.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it
from that location.

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you
must give the user the right to “Increase Scheduling Priority.” This must be done within the
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving
the right to a group and adding the user to that group. You will not be able to launch as a regular
user if this is not set properly.


http://www.avid.com/US/products/media-composer#specifications

After Installing the Editing Application
If you are part of a domain, a Domain Administrator should install and perform the first launch
of the editing application.
Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a
Shared Storage environment, mount your workspaces as an Administrator. You may then log off
and log back in as a Standard user, if necessary.

After Installing the Editing Application

AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background
Services” in the Help.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 8 GB of RAM. Some features might require
more RAM and specific hardware. See “Feature Performance” on page 17 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 17 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware.



Qualified Hardware and Operating Systems

For 3rd-Party Open 1O hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware
the qualified Operating Systems are:

*  Windows v7 64-bit SP1(Professional) and Windows v8.1 (Professional and Enterprise),
Windows 10 64-bit (Professional and Enterprise).

e Macintosh v10.10.5, 10.11.6, v10.12.3

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:
1. Click on your system drive (Macintosh HD in most cases) to highlight.
2. From the File menu select Get Info (cmd+I)
3. Click the lock icon in the bottom right to make changes
4

. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

If you repair permissions on the system drive, they will reset and you will have to repeat this
procedure.

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing
applications.

Qualified PC Workstations with Avid Media Composer

The following PC Workstations are qualified with Avid Media Composer.


http://avid.force.com/pkb/articles/en_US/faq/en422991

Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP 7840 Dual [8-16 core 2.3 Ghz or higher]
16/32/64 GB DDR4-2133 memory

HP 7640 Dual [6, 8, or 12 core 2.3 Ghz or
higher]

16/32/64 GB DDR4-2133 memory

Dell 7910 Dual [6, 8, or 12 core 2.3 Ghz or
higher]

16/32/64 GB DDR4-2133 memory

Dell 7810 Dual [6, 8, or 12 core 2.3 Ghz or
higher]

16/32/64 GB DDR4-2133 memory

Lenovo P900 Dual [6, 8, or 12 core 2.3 Ghz or
higher]

16/32/64 GB DDR4-2133 memory

Lenovo P700 Dual [6, 8, or 12 core 2.3 Ghz or
higher]

16/32/64 GB DDR4-2133 memory
HP 7820 Dual 6-core E5-2630V2 2.6 Ghz, 8

core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2
2.4 Ghz 16/32 GB DDR3-1866 memory

Dell T7610 Dual 6-core E5-2630V2 2.6 Ghz, 8
core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2
2.4 Ghz 16/32 GB DDR3-1866 memory
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NVIDIA K4200 or
K5200

M4000, M5000,
M600

AMD W7100 or
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000
AMD W5100,
W7100, W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000
AMD W7100,
W8100

NVIDIA K4200 or
K5200

M4000 or M5000
AMD W7100 or
W8100 or W5100

NVIDIA K4200 or
K5200

M4000, M5000,
M6000

NVIDIA K4200 or
K5200
M4000 or M5000

K4000

K4000

Software Only
Nitris DX
Mojo DX
Artist DNxIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell T5610 Dual 6-core E5-2630V2 2.6 Ghz, 8
core E5-2650V2 2.6 Ghz, or 12 core E5-2695V2
2.4 Ghz 16/32 GB DDR3-1866 memory

Lenovo D30 Dual 6-core E5-2630V2 2.6, 8 core
E5-2650V2 2.6, or 12 core E5-2695V2 2.4
16/32 GB DDR3-1866 memory

Lenovo C30 Dual 6-core E5-2630V2 2.6, 8 core
E5-2650V2 2.6, or 12 core E5-2695V2 2.4
16/32 GB DDR3-1866 memory

HP 2820 Dual 8 Core Intel Xeon E5-2665 2.4
GHz, Quad 6-core E5-2640 2.5 GHz

Lenovo D30 Dual 6 core E5-2640 2.5Ghz or
Dual 8 core E5-2660 2.2 GHz 16 GB
DDR3-1600 memory

Lenovo C30 Dual 6 core E5-2640 2.5GHz or
Dual 8 core E5-2660 2.2 GHz 16 GB
DDR3-1600 memory

Dell T7600 Dual 8 core Intel E5-2665 2.4 GHz
16 GB DDR3-1600 memory, Dual 6-core
E5-2630

Dell T5600 Dual 6-core Intel E5-2630 2.2 GHz
16 GB DDR3-1600 memory, Dual 8-core 2665

Lenovo ThinkStation E31, Intel Xeon
E3-1245V2 3.40 GHz 8 GB DDR3-1600 RAM

HP Z440 6 or 8 core 3.0 Ghz or higher]
16/32 GB DDR4-2133 memory

11

K4000

K4000

K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q600 or
K600 HD4000

NVIDIA K2200
AMD W5100

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only

Software Only
Nitris DX
Mojo DX
Artist DNXIO



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell 5810 6 or 8 core 3.0 Ghz or higher]
16/32 GB DDR4-2133 memory

Lenovo P500 6 or 8 core 3.0 Ghz or higher]
16/32 GB DDR4-2133 memory

HP Z420 6-core E5-1650 V2 3.5 Ghz 8/16 GB
DDR3-1866 memory

Dell T3610 6-core E5-1650 V2 3.5 Ghz 8/16 GB
DDR3-1866 memory

Lenovo S30 6-core E5-1650V2 3.5 Ghz 8/16
GB DDR3-1866 memory

HP z420 6-core Intel E5-1650 3.2 GHz 8 GB
DDR3-1600 memory

Lenovo S30 6-core Intel E5-1650 3.2 GHz 8 GB
DDR3-1600 memory

Dell T3600 6-core Intel ES-1650 3.2 GHz 8 GB
DDR3-1600 memory

HP 7230 quad Xeon E3-1245V3 3.4 Ghz
8/16 GB DDR3-1600 memory Tower or SFF

HP Z240 quad Xeon E3-1245V5 3.5 Ghz
8/16/32 GB DDR4-2133 memory Tower or SFF

12

NVIDIA K2200

AMD W5100

NVIDIA K2200

NVIDIA K2000

NVIDIA K2000

NVIDIA K2000

NVIDIA Q2000 or

K2000

NVIDIA Q2000 or

K2000

NVIDIA Q2000 or

K2000

K600
HD4600

K620, K1200 (SFF),

K2200 (Tower),
HD530

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only
Nitris DX
Mojo DX
Artist DNXIO

Software Only

Software Only



Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card Supported with

Lenovo P310 quad Xeon E3-1245V5 3.5 Ghz K620, K1200 (SFF), Software Only
8/16/32 GB DDR4-2133 memory Tower or K2200 (Tower),

SFF HD530

Dell 3620 quad Xeon E3-1245V5 3.5 Ghz K620, K2200, Software Only
8/16/32 GB DDR4-2133 memory Tower HDS530

Dell 3420 quad Xeon E3-1245V5 3.5 Ghz K620, K1200 Software Only
8/16/32 GB DDR4-2133 memory SFF HDS530

Lenovo P300 quad Xeon E3-1246V3 3.5 Ghz ~ K600 or K620, Software Only
8/16/32 GB DDR3-1600 memory Tower or HD4600

SFF

Lenovo E32 quad Xeon E3-1245V3 3.4 Ghz K600, HD4600 Software Only
8/16 GB DDR3-1600 memory Tower or SFF

Dell T1700 quad Xeon E3-1245V3 3.4 Ghz K600 Software Only
8/16 GB DDR3-1600 memory Tower or SFF  HD4600

HP Z1 G2 All-in-one E3-1245V3 3.4 Ghz K2100M Mojo DX
8/16 GB DDR3-1600 memory Thunderbolt Intel HD4600 Software Only
Lenovo ThinkCentre Edge 93Z 17-4770S 3.1 Intel HD4600 Software Only
Ghz 8/16 GB DDR3-1600 memory quad core

All-in-One

HP Z220 Quad Xeon E3-1245V2 3.4 GHz 8 GB Q600 or K600 Software Only
DDR3-1600 memory (Tower or SFF) HD4000

HP Z1 Quad Xeon E3-1245V2 3.4 GHz8 GB  NVIDIA K1000M  Software Only
DDR3-1600 memory All-in-One or HD4000

Lenovo ThinkCentre Edge 927 17-3770S 3.1 Intel HD4000 Software Only

Ghz 8 GB DDR3-1600 memory  Quad core
All-in-One

13



Qualified Hardware and Operating Systems

Qualified PC Notebooks for Avid Media Composer
The following PC Notebooks are qualified with Avid Media Composer. The following applies to
the editing system when running on a laptop:

e DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading
enabled. Nitris DX is not supported on laptops.

*  Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.
*  Playback in full quality 10 bit mode is not supported

Qualified PC Notebooks Graphics Cards Supported With

Dell 7710 17" 2.7 Ghz quad core i7 or 2.9 Ghz  M3000M,
Xeon E3 1920x1080 or 3840x2160 - 8/16/32  M4000M, M5000M
GB 2133Mhz DDR4L Memory AMD W7170M

Dell 7510 15" 2.5 Ghz and higher quad core i7 M1000M, M2000M Software Only
1920x1080 or 3200x1800 - 8/16/32 GB AMD W5170M
2133Mhz DDR4L Memory

Dell 5510 15" 2.3 Ghz and higher quad core i7 Nvidia M1000M Software Only
1920x1080 or 3840x2160 - 8/16 GB 2133Mhz
DDR4L Memory USB-C

Dell 3510 15" 2.3 Ghz and higher quad core i7 AMD W5130M Software Only
1920x1080 - 8/16 GB 2133Mhz DDR4L

Memory

HP Zbook 14" 2.1 Ghz dual core 17-4600U Intel HD4400 Software Only
1920x1080 - 8/16 GB 1600Mhz DDR3 FirePro M4100

Memory Ultrabook

HP Zbook 15" G2 - 2.5 Ghz and higher quad ~ K1100M Software Only
core 17 1920x1080 - 8/16/32 GB 1600Mhz K2100M Mojo DX
DDR3 Memory thunderbolt Artist DNxIO
HP Zbook 15" 2.4 Ghz and higher quad core i7 K1100M Software Only
1920x1080 - 8/16 GB 1600Mhz DDR3 K2100M Mojo DX
Memory thunderbolt

HP Zbook 17" G2 - 2.5 Ghz and higher quad ~ K3100M Software Only
core 17 K4100M I\A/quo ]1)))15I o
1920x1080 - 8/16/32 GB 1600Mhz DDR3 550011 rtist DRx
Memory thunderbolt

14



Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With

HP Zbook 17" 2.4 Ghz and higher quad core i7 K3100M Software Only

1920x1080 - 8/16 GB 1600Mhz DDR3 K4100M Mojo DX

Memory thunderbolt

Dell M3800 15" 2.2 Ghz and higher quad core K1100M Software Only

17 1920x1080 or 3200x1800 - 8/16/32 GB K2100M Mojo DX

1600Mhz DDR3 Memory Ultrabook

Dell M4800 15" 2.4 Ghz and higher quad core K1100M Software Only

17 1920x1080 or 3200x1800 - 8/16/32 GB K2100M Mojo DX

1600Mhz DDR3 Memory

Dell M6800 17" 2.4 Ghz and higher quad core K3100M Software Only

17 19201080 - 8/16/32 GB 1600Mhz DDR3 K4100M Mojo DX

Memory

Lenovo W541 15" 2.5 Ghz and higher quad K1100M Software Only

core i7 15" 1920x1080 2880x1620 - 8/16/32 K2100M Mojo DX

GB 1600Mhz DDR3 Memory Thunderbolt Artist DNxIO

Lenovo W540 15" 2.4 Ghz and higher quad K1100M Software Only

core i7 15" 1920x1080 2880x1620 - 8/16 GB K2100M Mojo DX

1600Mhz DDR3 Memory Thunderbolt

Lenovo ThinkPad W530 NVIDIA Quadro  Software Only

"Intel Core i7-3720QM 2.6 GHz, i7-3820QM  K1000M or Mojo DX

2.7GHz, 17-3920XM 2.9GHz K2000M

HP 8770w 17-3720QM 2.6 GHz, 17-3820QM  NVIDIA Quadro Software Only

2.7Ghz, 17-3920XM 2.9GHz 17" 1920x1080 - K3000M or Mojo DX

8 GB 1600MHz DDR3 Memory K4000M

HP 8570w 17-3720QM 2.6GHz, i7-3820QM NVIDIA Quadro Software Only

2.7 GHz 15" 1920x1080 - 8 B 1600Mhz K1000M or Mojo DX

DDR3 Memory K2000M

Dell M6700 i7-3740QM 2.7 GHz 17" NVIDIA Quadro  Software Only

1920x1080 - 8 GB 1600Mhz DDR3 Memory = K3000M or Mojo DX
K4000M

Dell M4700 17-3740QM 2.7 GHz, 15" NVIDIA Quadro Software Only

1920x1080 - 8 GB 1600Mhz DDR3 Memory =~ K1000M or Mojo DX
K2000M

Qualified Macintosh Workstations for Avid Media Composer
The following Macintosh Workstations are qualified with the Avid Media Composer.
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Qualified Hardware and Operating Systems

Qualified Macintosh Hardware Graphics Cards Supported With
Mac Pro 6 core 3.5 Ghz, 8 core 3.0 Ghz, 12 AMD FirePro D500  Software Only
core 2.7 (Late 2013) 16/32 GB 1866Mhz Mojo DX
DDR3 Memory Thunderbolt - no PCI-e slots Nitris DX (no HD capture)
Artist DNxIO
Mac Pro “Westmere” Two 2.66GHz 6-Core  ATI Radeon HD 5770 Software Only
Intel Xeon (12 cores) Nitris DX
Mojo DX
Artist DNxIO
iMac Retina SK 27" 4.0 Ghz i7 Quad core ~ Radeon M390, M395, Software Only
Late 2015 - 8/16/32 GB 1600Mhz DDR3 M395X Mojo DX
Artist DNxIO
iMac Retina SK 27" 4.0 Ghz i7 Quad core Radeon M290X, Software Only
Late 2014 - 8/16/32 GB 1600Mhz DDR3 M295X Mojo DX
Artist DNxIO
iMac 27” 2.9GHz Quad-core Intel i5, 3.2Ghz NVIDIA GeForce Software Only
Quad-core Intel i5, 3.4 GHz Quad Core Intel GTX 660M or Mojo DX
i7 (Late 2012) NVIDIA GeForce
GTX 675MX
iMac 21.5” 2.9GHz Quad-core Intel i5, NVIDIA GeForce Software Only
3.1GHz Quad-core Intel i7 (Late 2012) 650M Mojo DX
Mac mini 2.3/2.6GHz quad core Intel i7 Intel HD 4000 Software Only
Mojo DX
Mac Mini Server 2.0 GHz i7 Quad core Intel Software Only
Thunderbolt - 4GB 1333MHz DDR3 3000 Mojo DX

Qualified Macintosh Notebooks for Media Composer

The following Macintosh notebooks are qualified with the current editing applications. The
following applies to the editing system when running on a laptop.
*  HD Capture on Macintosh notebooks is not supported

*  Playback in full quality 10 bit mode is not supported
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Qualified Macintosh Notebook

Graphics Cards

Feature Performance

Supported With

MacBook Air 13" - 1.7 Ghz and higher i7
Dual-Core (Mid 2013) - Thunderbolt - 8 GB
1600Mhz DDR3L

MacBook Air 13" -2.0 GHz I7 Dual-Core
Thunderbolt - 8 GB 1600MHz DDR3L

MacBook Pro 15" 2.3/2.6/2.7 GHz 17 (Late
2013) Quad-Core - Retina & Thunderbolt

8 GB 1600Mhz DDR3L Memory

MacBook Pro 15" 2.3/2.6/2.7 GHz 17
(Mid/Late 2012) Quad-Core - Retina &
Thunderbolt

8 GB 1600Mhz DDR3L Memory

Intel HD5000

Intel HD4000

HD5000
GeForce GT 750M

HD4000
GeForce GT 650M

Software Only
Mojo DX

Software Only
Mojo DX

Software Only
Mojo DX
Artist DNxIO

Software Only
Mojo DX
Artist DNxIO

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features. For a list of the
qualified systems, see Qualified Workstations and Laptops.
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Feature Performance

Feature

Description

Recommended System

Editing High Resolution,
High Frame Rate Media
(UHD/4k in 59.94p)

Editing High Resolution
Media (Higher than 2K+)

DMF and Background
Transcode, Background
Render

Media Composer | Cloud

J2K Capture

XDCAM Long GOP
9-way MultiCam with
high stream count
sequences

16 GB RAM minimum, 32 GB
recommended

16 GB RAM minimum

8 GB RAM minimum. 16 GB
RAM recommended

16GB RAM minimum. 24 GB or
higher recommended depending
upon system model.

Avid recommends 16 GB RAM
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HP 7820, HP Z840, Dell 7810, Dell
7910, Lenovo P900, Lenovo P700

* Dual 8 core (32 cores with

Hyperthreading),

* Dual 10 core (40 cores with
Hyperthreading),

* Dual 12 core (48 core with
Hyperthreading)

* NVIDIA 5200 PCIe Gen3 Gfx card
(recommended)

+ NVIDIA 4200

Mac Pro

* 12 core (24 with Hyperthreading)
3 GHz

* Dual AMD FirePro 500/700 Graphics
card

Storage: 10Gb Ethernet ISIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

17 Quad core or higher with
Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS,



Feature Performance

Feature

Description

Recommended System

Stereoscopic 3D

XDCAM HD50 Capture

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

AMA (RED)

AMA (QuickTime)

AVClI-Intra Capture

For optimal performance with
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 12GB
RAM when using Stereoscopic
3D.

Baseband capture through Nitris
DX, Mojo DX

HD RGB capture requires a high
end workstation with Nitris DX
and fast storage.

AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.
you will get better performance
with higher end workstations.

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

AVC-Intra capture with software
codecs is supported.
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Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified systems

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Qualified Xeon Workstations

Recommendation of qualified systems
depends on your planned use of this
feature. Heavy usage of highly
compressed codecs requires the high end
systems. (Dual 6 Core or Dual 8 Core
systems)

24 core and higher Windows systems
only.

Note: If problems are encountered, please
use a Nitris DX w/AVC-I capabilities or
ingest at another resolution like DNxHD
and transcode to AVC L.



Compatibility Chart

Feature Description Recommended System

AVCl-Intra AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback

Fluahty’ low p1t—rat§ HD codecand Dual Quad Core, Dual 6 Core or Dual 8
is very CPU intensive. C
ore Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8
Core Systems

AMA Workflows: Dual Quad, Dual 6 or
Dual 8 core systems

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage,
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the
Avid editing applications.

IMPORTANT: For information on third party support (for example, Sorenson, Boris,
etc) see the third party’s web site.

Item Versions Comments

QuickTime Support  v7.7.9 (Windows) Note: QuickTime v10X does not include
v10.x, (v7.x legacy) (Macintosh) QuickTime Pro options.

Note: QuickTime is not supported with

Windows 10.
Windows Media Windows Media Player 12 (for ~ If you do not have Windows Media
Version Support Windows 7) Player, access the download at

www.microsoft.com.

Windows Media export compatibility is
subject to Microsoft Windows Media
updates.
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http://www.microsoft.com/en/us/default.aspx

Compatibility Chart

Item Versions Comments
Avid Interplay See Knowledge Base articleon =~ IMPORTANT: The Avid Interplay
Support compatibility. components that get installed on the

editing application must be updated to
the Avid Interplay version that is released
with the editing application. These
include the Media Indexer, Interplay
Access, Interplay Framework, Interplay
Transfer Client and ProEncode Client.
The Avid Interplay Server components
can remain on the previous releases listed
as supported. For details, see the “Avid
Editing Application Compatibility with
Interplay Releases” doc on the

Knowledge Base.
NVIDIA Driver 375.86 See “Setting up the NVIDIA Card” on
Support page 26.

For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

Shared Storage Avid NEXIS and Avid ISIS®. See “Shared Storage Support” on
Support page 27.
Sony XDCAM driver v2.13 (XDCAM Transfer for The VFAM firmware version for
Macintosh) PDW-U1 is 2.600.
Windows FAM v2.3.2and VFAM  Lh¢ PDW-U2 is 2.810.

The driver can be downloaded from

va.0.2 Sony's website http://esupport.sony.com/.
Panasonic P2 drive (Macintosh) v3.1.7 There is currently no P2 writeback
(Windows) v2.24 support for Macintosh clients.
Avid Artist Series EuControl software v3.4 See the User’s Guide for information on
(Euphonix) Artist Series Color setup information.
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Avid Editing Application Compatibility with Pro Tools

Avid Editing Application Compatibility with
Pro Tools

General Co-Installation Notes:

Install Pro Tools first and then Media Composer.

You must uninstall all older versions of Media Composer or Pro Tools before installing
newer versions.

Co-install does not support both applications launched simultaneously.

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first
uninstall option - “Pro Tools Only” - which is not selected by default.

Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be
connected in a co-install configuration for use with Pro Tools 10.

If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio input/output
operations. You can also use these audio devices with a software-only version of your Avid
editing application.

If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

If you want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device Support

Co-installation Configurations and Audio Device
Support

Avid Pro Tools Applications

MC/NC MC/NC
Pro Tools Software with Mojo MC/NC/
Product Only DX with Nitris DX
Pro Tools Co-install Co-install Co-install

Software Only

Pro ToolsfHD  Co-install/ Co-install Co-install
Native Audio Device

Pro ToolsHD  Co-install/ Co-install Co-install
Audio Device

Pro Tools/HD, Not Tested  Not Tested  Not Tested
with chassis

Avid Mbox Family Audio Devices (3rd Generation)

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox Co-install/ Co-install Co-install
(USB) Audio Device

Mbox Pro Co-install/ Co-install Co-install

Audio Device

Mbox Mini  Co-install/ Co-install Co-install
(USB) Audio Device

Avid Mbox 2 Family Audio Devices

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Co-install/ Co-install Co-install
(USB) Audio Device
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External Controllers

Other Avid Audio Devices

Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Pro Co-install Co-install Co-install
(1394)
Mbox 2 Co-install/ Co-install Co-install
Mini (USB) Audio Device
Mbox 2 Co-install Co-install Not tested
Micro
(USB)
Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Digi 002 Co-install/ Co-install Co-install
(1394) Audio Device

(Windows)
Digi 003 Co-install Co-install Co-install
(1394)
Eleven Rack Not Supported Not Supported Not Supported

(USB)

Fast Track  Audio Device Not Supported
Pro (USB)

Not Supported

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

*  Digi 002 (Windows only)
+ Command|8

*  Avid Artist Control

*  Avid Artist Mix
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External Controllers

*  Avid Artist Transport
*  Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Avid

Digi 002 Command| Artist Avid Avid Artist Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
Provides audio Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation
gain
Record Yes Yes Yes Yes No
automation pan
Flying faders ~ Yes (8) Yes (8) Yes (4) Yes (8) No
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
Solo/mute Yes Yes Yes Yes No
Supports audio No? No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable
steps of fader
accuracy
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Setting up the NVIDIA Card

Avid
Digi 002 Command| Artist Avid Avid Artist  Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or
automation pan controller or control surface.

For more information on using these external fader controllers or mixers, see “Recording
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. See the “Compatibility
Chart” on page 20 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder
that installs with your Avid application.

Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.
To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \Utilities \nVidia and double-click the folder that
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.
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Shared Storage Support

To set the Driver for Avid Editing Environments
1. Right-click the Desktop, and select Nvidia Control Panel.
Click Manage 3D Settings.
Click the Global Setting tab.
Under Global presets, select Base Profile.
Scroll to locate the Power Management Mode. Select Prefer maximum performance.
Click Apply.

A S

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following.

Avid
NEXIS
Editing Avid NEXIS Client and
Application ISIS | 2500- ISIS 2000 Server | PRO (ISIS Avid
Operating ISIS | 5500- ISIS 5000 Server | 1000 NEXIS
System ISIS Clients ISIS | 7500- ISIS 7000 Server Server) Server
Windows 10 v4.7.9,v4.7.10, v4.7.9,v4.7.10 v5.0 v6.0.x
v5.0 v6.1.x
v6.2.X
v7.1.x
Windows 8.1 v4.7.10, v5.0 v4.7.10 v5.0 v6.0.x
v6.1.x
v6.2.xX
v7.1.x
Windows 8 v4.5,v4.6.1,v4.7- v4.2.2 Kit, v4.5,v4.6.1, v4.7 - v5.0 v6.0.x
v4.7.4, v4.7.4,v4.7.5 v6.1.x
v4.7.5 -v4.7.10, v6.2.X
v5.0% v7.1.x
Windows 7 64-bit  v4.2, v4.5,v4.6.1, v4.2.2 Kit, v4.5,v4.6.1, v4.7 - v5.0 v6.0.x
v4.7 -v4.7.4, v4.7.4,v4.7.5 v6.1.x
v4.7.5 - v4.7-10, v6.2.X
v5.0 v7.1.x
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Shared Storage Support

Avid

NEXIS
Editing Avid NEXIS Client and
Application ISIS | 2500- ISIS 2000 Server | PRO (ISIS Avid
Operating ISIS | 5500- ISIS 5000 Server | 1000 NEXIS
System ISIS Clients ISIS | 7500- ISIS 7000 Server Server) Server

Macintosh v 10.10 v4.7.4, v4.7.4,v4.7.5 v5.0 v6.0.x
v4.7.5 -v4.7.10, v6.1.x
v5.0 v6.2.X

v7.1.x

Macintosh v10.11.x v4.7.7 - v4.7.10 v4.7.7 v5.0 v6.0.x
v6.1.x
v6.2.X
v7.1.x

a. ISIS Client v5.0 is applicable to ISIS | 1000 server only.
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Shared Storage Support

Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2016 Avid Technology, Inc. and its licensors. All rights reserved.
Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, INEWS, ISIS,
Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and
all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or
other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility
for Avid products. All other trademarks are the property of their respective owners. For a full list of Avid trademarks, see:
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows

is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.

Avid Media Composer ReadMe * Created 6/1/17
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